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Registration

To make full use of all the facilities please carefully read the Drawing a Design section and the 
Libraries Section.

This program is Copyright © 1994,1995 Matt Pyne. It is licensed to you at no charge.    The license agreement 
follows.

The program, help file, sample designs and library files are all Copyright © 1994,1995 Matt Pyne.
These files may be distributed without payment as long as all the files are kept together in their original format.
No charge, of any kind, in any form, may be made for the distribution of these files.
This license can be terminated at any time simply by the deletion of all copies of this program held by you.

This program was written in Windows NT using Microsoft's Foundation Class Libraries.



An Introduction to TinyCAD

Welcome to TinyCAD!

This program is an entry level Circuit Design package.    It contains all the necessary features to 
allow you to draw your circuit diagrams in a professional manner.

Once you have drawn your design, you can use the special functions to automatically add symbol
references, check your design against rules of correctness and create a parts list.

You may print your design to any supported Windows printer.    If your design is larger than a 
single page then it can be either scaled to fit on a single page or printed across many pages.

A large number of pre-drawn symbols are supplied to enable you to start right away without 
having to draw your own.    You can, of course, modify or add to the symbols supplied using the 
library editing features built into this program.

Some examples of designs that can be drawn using this package are also supplied.    Looking at 
these will not only show you the power of this program, but also demonstrate how to use some of
its features.

Improvements for version 1.26

Along with general enhancements of bug fixes, version 1.26 has had the following enhancements
added:

- Support for Windows 95
- Cut, Copy and Paste operations from and to the clipboard have been added, enabling copying 
into other applications such as Microsoft Word.
- The edit option on the toolbar has been enhanced to enable easy move and deletion of objects.
- Symbol Attributes for use with net lists
- Read and write designs as ascii text files
- Lines can now be coloured and with many different dot-dash styles
- Information bar at the bottom of the design window
- A ruler in the design window



Drawing a Design

Designs are created from in-built objects such as wires, junctions, etc., and from imported 
component symbols, such as diodes, transistors, etc.

Tell me more about...
An overview of how to draw a new design
Using Wires, Junctions
Using Symbols and No Connects
Adding Power
Using Labels
Adding Buses
Adding Text and Annotations



An overview of how to draw a new design

It is essential that you use each of the tools correctly for TinyCAD to function properly.    You 
must, for example, use wires not lines to connect components.    If you were to use lines, the 
special tools, which are an important part of this program, would not function correctly.

It is also important that for the majority of operations you use the grid snap feature.    This 
ensures when a component is connected to a wire that the connection point is at the very end of 
the wire.    Without snapping to the grid it is very hard to ensure that the wire connects exactly to 
the end of a component's pin.    Unless it does so they are not considered connected.    The same 
is true of junctions.    Unless a junction is placed exactly at the point where the two wires cross, 
they are not considered connected.

Designs are drawn by using the drawing tools, which are selected in the Toolbar.    Each of the 
tools is detailed in the Toolbar Reference Guide.

Commonly used tools can be selected using the keyboard.    You may find, once you have learned
the key presses, that it is faster to use the keyboard than repeatedly returning to the toolbar or 
menu with the mouse pointer.
Some of the tools use an edit window separate from the design window.    When this window is 
highlighted you cannot select a new tool using the keyboard.    Ensure the design window is 
highlighted before pressing a key.    This can be achieved by clicking in the design window, 
normally with the right hand mouse button or on the window's title bar.

Whilst drawing an object you may wish to move to another area of    the design, so that you can 
move the object to a part of the design not currently shown.    This can be achieved by using the 
scroll bars at the sides of the design window, or by pressing the C key ('C' for centre), this will 
only work if the design window is highlighted.    You can also zoom in and out by using the + 
and - keys.

Once an object has been placed you may want to change its properties.    Select Edit Item in the 
Edit menu, then click with the left hand mouse button on the object you wish to change.    This 
will cause a dialogue box to be displayed which will allow you to change the object.    
Remember, not all objects can be edited, and clicking on such objects will have no effect.

You can move objects by using the Move Block and Drag Block options in the Edit menu.    
Objects can be deleted using the Delete Item or Delete Block options in the Edit menu.

A final tip - remember to save the design regularly!    It is always possible that the machine will 
crash or that you will make a mistake causing you to want to revert to an earlier version of the 
design

See also: Toolbar Reference



Using Wires, Junctions

The correct use of wires and junctions

Wires are used for connecting components of your design.    Where two wires cross they are not 
considered joined unless a junction is used at the crossing point.
Junctions are also required when a pin or a power is connected to the middle of a wire.

When connecting a wire to a symbol, wires must connect to the very end of the pins; otherwise it
will not be considered connected.    To ensure this happens use the Snap to Grid option (in the 
View Menu).

See also: Junction, Wire



Using Symbols and No Connects

Symbols are the heart of a design.    They represent the components in the design.
Symbols are stored in groups in symbol libraries.    Each library contains a different collection of 
symbols.    Each symbol is accessed in the library by a name.    Every symbol in the library must 
have a unique name.

At any one time a certain number of symbol libraries are in use.    You can extract a symbol from 
one of these libraries and place it into your design using the Get option on the Toolbar.    Enter 
the name of the symbol you want and each library will be searched (one after the other), until a 
symbol of that name is found.
If no symbol of the name you entered is found then you are told so, and the operation is 
cancelled.    If the symbol is found then it is displayed next to the mouse pointer.    You can move 
the symbol around the design and place it using the left hand mouse button.
The libraries to be searched are listed in the libraries option of the Library Menu.    Before you 
can start using symbols at least one symbol library must be listed here.    (See the Library Menu, 
in the menu reference for more help on adding a library to this list).

A symbol can be rotated or mirrored before it is placed.    Once it is placed you can still edit all 
its details, by using the edit item in the Edit menu.

Each symbol has three text fields associated with it.
- The Name field
This is the name of type of the component that the symbol represents.    If the component has a 
value then insert the value here.    For example, if it were a resistor then the name might be 330R 
or 4k7.    If the symbol represents a phono connector then the name might be Phono.
- The Reference field
This is an identifier that is unique to the whole design.    For example, there may be many 
resistors each with a Name field of 330R, however, each resistor must have a different 
Reference.    There will only be one symbol with reference R1 in a design.
- The Other field
This is not defined in use and is to allow any extra information about the symbol to be added 
with it.    For example, this may be a power rating or outline type.

You can move its text fields around by selecting the symbol for editing, and then clicking on the 
field you wish to move.    The field will now move with the mouse.



All the pins on a symbol must be connected.    If you do not wish to connect to a certain pin then 
use the no-connect option on the Toolbar.    Place a no-connect on every pin that is not to be 
connected to anything else.    If you do not do this then the Design Rules Checker in the Special 
menu will warn you of unconnected pins on symbols.

See also: No Connect, Get



Adding Power

The correct use of power objects

Power objects in your design show where power is connected into your circuit.    Various shapes 
of power symbols are defined.

You must always make the connection to power at the end of the line.    A junction may be 
necessary if the connection is to the centre of a wire or where wires cross.

The shape of the power object is ignored it is the value of the power item which is important.    
All items connected to power objects of the same value are considered connected together.

Some component symbols, such as the 74 TTL library symbols, are automatically connected to 
power.    To ensure the power is correctly connected, always use the same power names that are 
used in the library.    For example, when using the 74 TTL library use the power names GND and 
VCC for 0v and 5v respectively.

See also: Power



Using Labels

Labels enable you to make connection between points on your design which are some way apart. 
They are also useful for when many connections are required to the same point.

Correctly placed labels

Incorrectly placed labels!

A label should be placed above or alongside a wire.    The label is considered connected at the 
bottom left hand corner of the label when the label is horizontal (Right) and the bottom right 
hand corner when the label is vertical (Up).

All wires with the same label name will be considered connected together.    This way a 
connection between the wires is formed without you having to actually draw it.

See also: Label



Adding Buses

A correctly drawn bus

Buses can be used to indicate a large number of connections.    To help you draw a bus the repeat 
options are present.

To create a bus, first draw the bus near where you wish to connect it.    Now add a bus entry to 
the bus.    Press 'R' (for repeat in the Edit Menu) to repeat this as necessary for the number of 
entries you wish to make.
Draw a wire from the bus entry to the connection point.    Now press 'R' again, to complete all the
wire connections.
Finally you must add the labels.    Place the first label.    Depending on your repeat options the 
label name will be updated automatically.    Place a label over each wire.
Now the bus connection is complete!

Use the same names for the bus entries on all connections to bus; however, the order of the 
names is unimportant.    Buses do not require junctions anywhere on them.

Once a bus is in place, you may name the bus using the Bus Name tool.    You may use this to 
place some text next to the bus.    The name can indicate how many conductors the bus 
represents, by specifying just a single number, or it may qualify what the bus is for example by 
calling it "Data Bus" etc.

See also: Bus, Bus Entry, Label, Wire, Get





Adding Text and Annotations

An example of the use of annotations

You may add the annotations; text, lines, rectangles, ellipses and arcs.    All these objects will be 
ignored by the special tools.

Annotations may cross wires, symbols and junctions without affecting them.    How these objects
are used is completely up to you.

See also: Arc segment, Ellipse, Line, Rectangle, Text



Printing a Design

Once your design is drawn it can be printed to any Windows-supported printer.

The printing options available are outlined in the Print option in the File Menu, detailed in the 
Menu Reference guide.

A design can be scaled to fit the page it is to be printed to.    If the design will not reasonably fit 
on a single page then it can be 'tiled' across many pages.    That is, each page will contain a 
different section of the design.    Once all the pages have been printed, the pages can be stuck 
together to form the whole design.

The design, when shown on screen, is in colour.    When printing to a monochrome printer, it is 
best to print only in black and white.    Otherwise the printer will attempt to use greys for each of 
the different colours.    This can be undesirable because it produces a poor quality printout.    For 
this reason the "all colours to black" option is provided.    When this option is checked the entire 
design will be printed in black and white only.    Should you wish to use a colour printer, simply 
un-check this option.

For the best results when drawing a small design, use the Printer Setup option in the Page Setup 
dialogue.    This will ensure the design's dimensions will have the same dimensions as the 
printer's output, making scaling unnecessary.

If you do have any problems when attempting to print, before blaming TinyCAD, try printing 
using a different program which you know to work.    This will help sort out any problems which 
may be caused not by this program, but by the printer or Windows being incorrectly set-up.

See also: Page Setup, Print



An Introduction to Libraries

Component symbols form a very important part of laying out designs.    Symbols are collected 
together in symbol libraries.    You may edit and create your own new symbols and libraries.

It is unlikely that the symbol libraries provided can ever cover all the symbols you could ever 
want.    This program has been designed to allow you to create your own symbols very easily.

Tell me more about...
Selecting libraries
Editing and adding symbols
Creating a new symbol library

See also: Library Menu



Selecting libraries

Before any symbols can be used from a library, the library must be selected as in use.    This is 
done by using the Libraries option in the Library menu.

This dialogue displays a list of libraries in use.    Before a library can be edited or before a 
symbol can be extracted from a library it must be listed here.    Once the library is listed then you 
can extract symbols from it using the Get option on the Toolbar.    If it is not listed, then the Get 
option will not examine that library for symbols and the symbol will not be found.

To add a library to this list click on the Add button.    A file selection dialogue will appear.    
Select a library index file (with a .idx file extension).    The selected library will be added to the 
list.
To remove a library from the list click on the library in the list to select it and then click on the 
Remove button.    This does not, in any way, delete the file and library is still available to others.  
To actually delete the library you must use the File Manager.

Libraries that do not exist can also be listed here.    If the library does not exist, then you will be 
informed every time the library's index is read.    This normally occurs when TinyCAD is first 
started and re-read libraries option in the Library menu is selected.
The non-existent libraries are not removed from the list because they can be edited.    As soon as 
the first symbol is saved into the library it is created automatically.
In this way you can create a new library.    First click on the Add button.    Now enter the name of 
a library that does not as yet exist.    This library name will be added to the list, although you will 
be warned it cannot be read.    Now select the library and click on the Edit button.    You are now 
able to edit the library - as though it did exist.    As stated above when you now store a symbol to 
the library for the first time it will be created automatically.

See also: Libraries, Re-read all Libraries, Store Symbol



Editing and adding symbols

Symbols are created from normal objects found on the Toolbar. They may contain any of these 
objects except other symbols.
If the symbol does contain any objects with special functions (such as a power item or a wire) 
then these object will be treated as though they were annotation.    All their special functions are 
lost when used in a symbol.

To edit an existing symbol, first select the library you wish to edit in the Libraries option of the 
Library menu.
Next use the Select Symbol to Edit option in the Library menu.    Enter the name of the symbol 
you wish to edit when prompted by a dialogue.    If you are unsure of the name of the symbol use 
the Names button in the Libraries option to list the names of all of the symbols in the library.
When the symbol has been selected you may place it anywhere in the current design window by 
clicking with the left hand mouse button.
Once the symbol has been placed it may be edited in the same way that a normal design can be 
edited, with the exception no symbols be in inserted and pins may be added.
When you have finished use the Store symbol option in the Library menu.    This will enable you 
to save the new symbol back to the library.    The dialogue box automatically remembers the 
details of the last symbol selected.    If you enter a different name here then the symbol will be 
store under the new name.    If you enter the name of an existing symbol then it will replace the 
old symbol in the library.

Connections to a symbol is via the pins.    It is important to correctly type each pin.    This enables
the Check Design Rules in the Special menu to operate correctly.
More than one set of pins may be added to a symbol.    Each set is stored in a different part per 
package.

See also: Libraries, End Editing Library, Select Symbol to Edit, Store Symbol, Part in Package



Creating a new symbol library

Creating a new library is easy.
Simply add the name of your new library to the list of libraries in use.    The new name will be 
accepted even though the library does not yet exist.    Remember to place the library in a 
directory you have read/write access to.

For more details on adding libraries to the libraries in use list see Selecting libraries.

The library will be created automatically when you first store a symbol into it.

See also: Libraries, Store Symbol



Registration

Remember to regisiter!    This program took a great deal of effort to write, and it would be 
helpful to know who and how they were using this application.

To register, please print this page, fill it in and return it.    If you like this program then please 
send £10 as well.

+==================================================================+

Registration for TinyCAD version 1.26

Name       Mr/Mrs/Miss/Ms _______________________
Forename(s) _____________________________________
Address:
____________________________________________________________________
____________________________________________________________________
Postcode __________________   Country _________________
Email Address _________________________________________

Which operating system do you use?
[ ] Win32s
[ ] Windows NT
[ ] Windows 95

Version ____________

What type of printer do you have? __________________________________

Where did you obtain this program? _________________________________

In the next version I'd like to see:
____________________________________________________________________
____________________________________________________________________

The following parts of the documentation are unclear/missing:
____________________________________________________________________
____________________________________________________________________

I have found the following Bug (please describe it as fully as possible):
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________

Please add any futher comments on the reverse of this form

Please return this form to:
Matt Pyne, 1 Brook End, Eversholt, Milton Keynes, MK17 9DT, England.
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Known Problems

There are several known problems when using TinyCAD.    Here are the comman problems.

Printing using a HP DeskJet II
Problem
TinyCAD fails to print and sometimes crashes when trying to set up the printer.

Solution
Change the printer driver from the HP driver provided with the printer to the Microsoft driver 
provided with Windows.    (See your Windows' manual for more details).

Working with Win32s
Problem
Once TinyCAD has exited it may cause Windows 3.1 or Windows 3.11 to crash!

Solution
I hope I have fixed this problem for this release, but it may still occur.    The cause of the problem
is unclear as this does not happen under Windows NT or Windows 95.    Generally speaking 
Win32s is not very stable and I would strongly recommend upgrading to Windows 95 as soon as 
possible.

Import in to a blank design
Problem
Import does not work correctly when used with a design that is blank.    The imported design is 
Load'ed instead of Import'ed.

Solution
Don't do it!    Or rather, Load instead of Import the design then use Move Block to place it in to 
the correct position.    I hope to fix this bug in the near future.



Menu Reference

Select which menu you wish to find out more about:

File Menu
Edit Menu
Library Menu
Special Menu
Options Menu



Menu Reference

Select which menu you wish to find out more about:

File Menu
New
Design Details
Open
Save
Save As
Import
Export
Print
Page Setup
Exit

Edit Menu
Library Menu
Special Menu
Options Menu



Menu Reference

Select which menu you wish to find out more about:

File Menu
Edit Menu
Undo
Redo
Repeat
Cut
Copy
Paste
Move Block
Drag Block
Duplicate Block
Delete Block
Rotate Block
Find
Tags
Set Tag

Library Menu
Special Menu
Options Menu



Menu Reference

Select which menu you wish to find out more about:

File Menu
Edit Menu
Library Menu
Libraries
Re-read all Libraries
End Editing Library
Select Symbol to Edit
Store Symbol
Part in Package
Add Pin

Special Menu
Options Menu



Menu Reference

Select which menu you wish to find out more about:

File Menu
Edit Menu
Library Menu
Special Menu
Check Design Rules
Create Net List
Generate Symbol References
Create Parts List
Tidy Design

Options Menu



Menu Reference

Select which menu you wish to find out more about:

File Menu
Edit Menu
Library Menu
Special Menu
Options Menu
Font
Line Style
Attributes
Grid Settings
Show Position
Repeat Directions
Re-Draw Window



New

This gets rid of the current design.    All drawings in the current design are removed.    If the 
current design has not been saved then you are asked to confirm before the design is lost.



Design Details

Each design has details of its full title, the author, etc.    This option allows you to change these 
details.    When the design is next saved, these details are saved with the design.

If the Display Details box is checked then these details will be displayed and printed in the 
bottom right hand corner of your design.



Open

This option opens a previously saved design for editing or printing.    If there is already a design 
being edited it will be lost.    If the current design has not been saved then you will be asked to 
confirm before continuing.



Save

This option saves the current design, its page set up and the design details are all saved in a 
single file.    If the design has already a file name associated with it then it will be saved using 
this file name without prompting.    If the design has never been saved then you will be prompted
for a new file name before it is saved.



Save As

This option is similar to the Save menu option; however, you will always be prompted for a file 
name.    Using this option you can save the current design using a new file name or place it into a 
different directory.



Import

Using this option you can place into the current design another previously saved or exported 
design.

When selected you will be prompted to enter the file name of a saved design.    This design will 
be loaded and displayed.    You can move the positioning of the imported design with the mouse.  
Place the design using the left hand mouse button or cancel the operation using the right hand 
mouse button.



Export

Using this option you can save just part of the current design.    This part can be loaded as a 
design in its own right, or imported into another design.

Once selected you must select the part of the design to export.    Do this by placing a rectangle 
around the area to select.    Click with the left hand mouse button to start placing, then move to 
the opposite corner and click with the left hand mouse button again.    Once placed the symbols 
selected by the rectangle will be highlighted.
This can be cancelled by using the right hand mouse button.
Then a dialogue box will prompt you to enter the file name to save the export design.    
Remember, this dialogue can be moved out of the way to see which parts of the design have been
selected.



Print

This will print the current design to any installed Windows printer.
The following are several options that can be selected when printing:

- Scale
This selects how big the design will appear on paper.    This option can be used, for example, to 
print designs that are bigger than a single page on one sheet, simply by selecting a scale smaller 
than 100%.

- Copies
This is the number of copies of the design that will be printed.

- Fit on one page
If this option is set, then only one page will be printed, regardless of the scaling.    When this 
option is selected the scaling will automatically be adjusted (if necessary) to ensure that the 
whole design will fit on a single page.    You may, however, change the scaling to any value you 
require.

- Tile on many pages
This option ensures the whole design will be printed.    If the design with the scaling given is 
larger than a single page, then more than one page will be printed, each one covering a different 
part of the design.    If the design will fit on a single page then only one page will be printed.

- All colours to be printed black
If this is checked then the printed design will be black and white only.    If left un-selected on a 
black and white printer then the various colours will be printed as various shades of grey, which 
is not normally acceptable.    This option should normally be checked when using a monochrome 
printer.    When printing to a colour printer the option should be un-selected.

To select which printer to use click on the printer setup button.    You will then be able to select 
printer, paper size etc.    These settings will also be remembered for the next time you print a 
design.



Start printing by clicking on the print button, or cancel using the cancel button.



Page Setup

This option allows you to select the total size of the design.
Some commonly used values are given.    If you prefer you can enter your own size in 
millimetres of the page.    Selecting Portrait will ensure the design is taller than it is wide; 
selecting Landscape will ensure the design is wider than it is tall.
The printer setup option is used with the printer setup button.    Click on the printer setup button 
and select the printer and the type of paper you will use.    Now when you return to the Set Page 
Size dialogue the width and height of the design will be set to match exactly the printable area of
the printer.
The page size is saved with the current design when it is saved.    The last page size entered here 
will be remembered for the next new design you start.



Exit

This option will exit the program and remove it from memory.



Undo

This option undoes the last action or sequence of actions performed on the design.    For example,
you can Undo the last drawing operation or undo the last deletion.

You may select this option repeatedly.    This will cause the design to return to even more distant 
versions.

The opposite of this option is Redo.



Redo

This option is the opposite of the Undo option.    If you select Undo then the last operation of the 
design will be undone.    If you then change you mind about the Undo, selecting Redo will 
reverse the action of Undo.



Repeat

If the last object placed in the design was repeatable, this option creates another copy of it in a 
new location (depending on the repeat direction).

Only wires, line, dashed lines, buses and bus entries can be repeated.
They are repeated above, below, to the left of, or to the right of, the last placed object.    This can 
be selected by the Up, Down, Left, Right option in the repeat directions menu.



Cut

This option enables you to move parts of the design which have been selected to the clipboard.    
Once it has been moved to the clipboard you may use paste to re-insert them into a different part 
of the design, and may paste again and again to duplicate a part of the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.



Copy

This option enables you to copy parts of the design which have been selected to the clipboard.    
Once it has been copied to the clipboard you may use paste to re-insert them into a different part 
of the design, and may paste again and again to duplicate a part of the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.



Paste

This option takes a previously copied or cut part of a design and enable you to place it into the 
current design.

Once this option has been selected the pasted design will be displayed at the mouse pointer.    To 
paste it in click with the left hand mouse button, to cancel click with the right hand mouse 
button.



Move Block

This option allows you to move parts of the design around.    The connections by wires are not 
preserved when this option is used.    If you wish to keep the connections use the drag block 
option.

Select the area you wish to move by drawing a rectangle around it.    Start the rectangle by 
clicking with the left hand mouse button.    Click again with the left hand mouse button again 
when the rectangle covers the area you wish to move.
The area selected will be highlighted.    You can now move this area around the design.    Place it 
by using the left hand mouse button.

You can cancel the move by clicking with the right hand mouse button.



Drag Block

This option allows you to move parts of the design, keeping the connections made by wires.    All
wires and buses that pass into the selected area to be moved will keep their ends outside the 
selected area fixed in place.    All connections to symbols by wires will also be preserved.
This allows for objects to be moved around the design without affecting how they are connected.

Select the area you wish to drag by drawing a rectangle around it.    Start the rectangle by 
clicking with the left hand mouse button.    Click again with the left hand mouse button again 
when the rectangle covers the area you wish to drag.
The area selected will be highlighted.    You can now drag this area around the design.    Place it 
by using the left hand mouse button.

You can cancel the drag by clicking with the right hand mouse button.



Duplicate Block

This option allows you to make another copy of part of the design to be placed somewhere else 
in the design.

Select the area you wish to duplicate by drawing a rectangle around it.    Start the rectangle by 
clicking with the left hand mouse button.    Click again with the left hand mouse button again 
when the rectangle covers the area you wish to copy.
The area selected will be highlighted.    When you move the mouse you will find that the original 
copy remains and you have a duplicate copy that can be placed anywhere in the design.    Place 
this copy by using the left hand mouse button.
 
You can cancel the duplication by clicking with the right hand mouse button.



Delete Block

This option allow you to delete a whole area of a the design.

Select the area you wish to delete by drawing a rectangle around it.    Start the rectangle by 
clicking with the left hand mouse button.    Click again with the left hand mouse button again 
when the rectangle covers the area you wish to delete.
The area selected will be highlighted.    You can delete this area by clicking on the delete button 
in the dialogue box.

Before the area has been deleted you can cancel by using the left hand mouse button.



Rotate Block

This option allows you to rotate and mirror (flip) a selected area of the design.    This makes it 
very easy to correct the mistake of placing a component the wrong way round, as it and all its 
connections can be rotated.

Select the area you wish to rotate by drawing a rectangle around it.    Start the rectangle by 
clicking with the left hand mouse button.    Click again with the left hand mouse button again 
when the rectangle covers the area you wish to delete.
The area selected will be highlighted.
A dialogue box will now give you options to rotate the block clockwise or anti-clockwise, by 
clicking on the <<< and >>> buttons.    You can also select the flip button which will mirror the 
block.
Once you have finished rotating the block click with either the left hand or right hand mouse 
button.



Find

This options can be used to find specific uses of text in the design.    The user enters the text to be
found.    This text is then searched for in the design.    Each occurance of the string is has a 
marker placed on it and all the occurances are placed in the design marker dialog.

The markers are removed from the design when the dialog box is close.    Clicking on the text in 
the dialog box moves the associated marker to the centre of the design window.



Tags

This option helps you navigate large designs.    Tags are names which mark specific points in the 
design.    When a tag is selected the design window is changed to display the area that is tagged.

When this option is selected it views all the tags in the design, and enables the deletion or 
jumping to the tag location.



Set Tag

This option prompts you to name the selected area, and adds the tag to the design.    When the tag
is re-selected using the Tags option, this same area of the design is displayed in the design 
window.

By naming different parts of the design, a large design can still be navigated using these tags.



Libraries

This option brings up the dialogue box which allows the setting up and editing of libraries.

The list in the dialogue box is a list of libraries searched when the Get option (in the Library 
menu) is used.    You may add or remove these libraries from this list using the buttons at the side
of the list.

The Add button in the dialogue allows a library not currently being searched to entered into the 
search list.    When this option is selected a file selection dialogue appears.    Select the index file 
(those files with .idx extensions), which belongs to the library you wish to use.    The library is 
then added to the list box.

The Remove button removes a library from the search list.    It does not delete it!    Select the 
library you wish to remove by clicking on it in the list box, then click on the remove button.

The Names button causes of a list of all the names of all the symbols in the library selected.    
Select a library to display the names of in the list by clicking on it, then click on this button.
In this new dialogue the symbol names can be printed.    Symbols can be deleted from the library,
or symbols can be renamed.
Note:    Once a symbol has been deleted from a library it cannot be recovered!    Use this option 
with care!

The Edit button allows a library to have new symbols added to it.    Select a library to edit by 
clicking on it in the list, then click on the Edit button.
Once this option has been selected and a library is being edited, some of the other options in the 
Library menu can then be used.    New library symbols are drawn as normal designs in the design
window.    A library is edited until a new library is selected to be edited or End edit is selected in 
the Library menu.
During editing other users can still use the library you are editing, however, they will not be able 
to access the new symbols.    After editing a library has finished, all users of the library will have 
to select re-read all libraries (in the Library menu) before they can access all the symbols in the 
library.



The Tidy button causes a library to be tidied up.    Select a library to tidy by clicking on it in the 
list, then click on the Tidy button.    When the library has been tidied a message box will appear 
informing you of this.
Libraries will need tidying after they have been extensively edited.    Tidying the library will 
make it smaller by removing the unwanted old (now deleted) symbols in the library.



Re-read all Libraries

This option causes all the libraries currently in use to be re-read, and any changes displayed in 
the current design.

This option can used if another user changes a library, at the same time you are using this 
program.    The new changes will not be available until you re-read the libraries, or re-start the 
application.

In the event of another user tidying a library, you must use this option before any new symbol 
can be extracted from that library.



End Editing Library

This option can only be selected when you are currently editing a library.
It closes the library, and clears the current design.
Use this option when you have finished editing a library.



Select Symbol to Edit

This option can only be used when you are editing a library.    It is similar to Get in the Library 
menu.    It asks you to enter a symbol name.    This symbol will be extracted from the library 
ready for editing.
Place the symbol somewhere in the current design by using the left hand mouse button.
You can cancel this operation by clicking with the right hand mouse button.

Once the symbol has been placed it can be changed, as each component of the symbol can be 
edited separately.



Store Symbol

This option can only be used when you are editing a library.

It causes the current design to be added to the library being edited.
When you select this option a dialogue box will appear prompting you for the symbol name in 
the library.    If you use a name already in use then the new symbol will overwrite the old.
You must also enter the default reference for the symbol..    This is the text that appears in the 
reference field of the symbol when it is first extracted from the library using the Get command.    
Remember that the reference should normally be a single letter followed by a ?.    For example: 
U?

Click the OK button to store the symbol, or the Cancel button to exit without changing the 
library.



Part in Package

This option can only be used when you are editing a library.
When a symbol has more than one part per package, this option allows you to edit each part 
individually.
Each part in the package must have the same symbol outline, but with different pins.    Therefore 
this option only effects the pins in the symbol.
When you select a new part per package, which has not yet been defined, you will be given the 
option to copy over the pins in the current part into the new part.    Select Yes, if you wish to have
the pins in the same layout for each part in the package.    This is highly recommended.    Once 
the pins have been copied, you can edit their pin numbers using the Edit Item option in the Edit 
menu.



Add Pin

This option can only be selected when you are editing a library.

Pins are used to show where the connections to each symbol are.
Pins of various shapes are provided, however, these shapes are for cosmetic purposes only.    
They do not effect how each pin is considered to be connected.

There are various types of pin.    These type govern how the electrical rules checker operates.    
The electrical rules checker checks which pins of what type are connected together and 
determines whether or not this will produce a correct circuit.

All pins must have a pin number.    If the device is not one that has pins numbers (such a 
capacitor), then what the numbers are is arbitrary - but they must all be different.    Pin numbers 
can also include letters.    This is so the pins of a Pin Grid Array device can be correctly labelled.
Pins can optionally have a name.    This is not necessary however.
The pin number and name can be shown or hidden.    To hide the text click on the check box next
to the text in the dialogue box.

Pins of type power are special.    Although they are shown when editing a symbol, when the 
symbol is placed in a design these pins are hidden.    Once the symbol is placed in a design pins 
are automatically connected to the power of the same value as their name.    Therefore these pins 
must have a name.    This can be used in conjunction with the parts per package option to allow 
the placing of, for example, logic gates, without need to show the power connection explicitly.    
A power pin cannot be connected to normally, all connections to this pin will be done 
automatically.

A pin of type hidden will be shown when editing a symbol, as with power pins, and hidden when
the symbol is placed into a design.    However, the normal connections are expected to be made 
to this pin, even though it is unseen.    The symbol design must indicate where these pins are to 
allow easy connection.

Each pin is associated with a part per package.    A single symbol may have more than one part 
per package.    For example a 7400, consists of 4 NAND gates.    Each part has different pin 
numbers on each pin.    To select which part per package the pin you are placing belongs to use 
the Part in Package option in the Library menu.

To place a pin click with the left hand mouse button in the design window.    When a pin has been
placed, the pin number in the dialogue box will automatically be advanced for you.
Placing can be cancelled by clicking with the right hand mouse button.
Once a pin is placed the pin number is either incremented or decremented, automatically for you.
The Pin Increment/Pin Decrement options in the repeat directions menu (in the Edit menu) select
which way the pin number is changed.
Also if the pin name has a number at then end of it then it too is also incremented or 
decremented.    The Name Increment/Name Decrement options in the repeat directions menu (in 



the Edit menu) select which way the pin name is changed.

Pins can be edited.    To edit them select the Edit Item option in the Edit menu, then click on the 
end of the pin (the same end as you placed, and would connect a wire to).

Pins can also be moved or deleted.



Check Design Rules

This option will cause the current design to be checked against a list of rules it must obey.
The rules test for gross errors in the design.    For example, they will tell you if two outputs are 
connected together.    They do not tell you if the design will work or not.    However, if the design
has errors in it picked up by this tool, then it is properly incorrectly drawn.

Once selected a dialogue box will appear.    Each rule that is checked can be turned on or off 
before the test is done in this dialogue box.

Once the OK is selected the design is checked.    Any errors are circled by a red ring.    A list of 
errors is displayed at the side of the design.    Clicking on any item in the list will cause that error 
to be moved to the centre of the design window.
Selecting Edit Item in the Edit menu, then clicking on an error will cause it to be highlighted and 
also cause the error name in the error list to be highlighted.

If the Done button in the list is selected all the errors will be removed from the design.

If no errors are found then a list will appear stating so.    This list can be removed by selecting the
Done button.

Error circles can edited, moved or deleted.    Error circles will not be saved with the design.



Create Net List

A net list is a file which contains a list of all the connections made in a circuit diagram.    All 
objects which are connected together are in a single list, called a net.    For symbols each objects 
pin is considered a different object.    Each net is given a different name.

Net lists are useful for programs such a PCB layout tools which can check you layout to see if it 
matches the layout of the circuit diagram, or even suggest a PCB layout from the net list.    These 
more advanced features will be better supported by this program in future releases.

Currently only one net list format is supported.    A simple to follow text file is produced.    In 
future I hope to support more output formats.    If you have a suggestion I would be glad to hear 
it, please include as much detail as possible.



Generate Symbol References

This option changes the symbol references in your design.    It relieves you of the task of 
ensuring each symbol has its own unique reference.

One this option has been selected a dialogue box will allow several options to be changed.    You 
can either add or remove the current references.    Removing references can be useful if you wish 
to integrate this design into another.

You can apply the changes to all references, that is the entire design will have potentially all of it 
references changed.    Use this option if you do have not yet built the design, or have not issued 
any copies of the design to others.
You can apply the changes to only un-numbered references.    This will ensure only new symbols 
with references with a ? in them will be changed.    Use this option if you are modifying an 
existing design, and wish to leave existing components with their original references.
You can apply the changes to only references matching a give reference.    This will apply to all 
references matching the one entered, even if the symbol has already been assigned a reference.    
Use this option, for example, to renumber all the capacitors without renumbering any other 
symbol.

If you wish you can allow this tool to determine what the correct symbol reference for the 
symbols is.    Alternatively you can enter your own.

When you select the OK button the options will be applied to the design.    Each symbol specified
will be given a new reference.    If you select remove references then each symbol will have its 
references changed back to one with a ? instead of a value.
You may select Cancel to not apply the reference generator.



Create Parts List

This option creates a list of all the parts used in the design.    This list is sorted by symbol 
reference, and all parts of the same type are listed together.
Essentially this is a list of parts that need to be purchased to make the design.

The parts list is store in a simple text file, which can be edited and printed using notepad.



Tidy Design

This option improves the way the design is stored    without effecting the way it looks.

In this release it does this by removing unseen object from the design.
This includes:
- Wires, buses, arcs and lines with zero length.
- Labels and text with no text in them.
- Rectangles and ellipses with no area.

This option removes errors than can creep in during editing which are difficult to remove 
yourself because they are unseen.

In future this option will cover further operations to improve the way the design is stored.    You 
should use this option from time to time to tidy up the design.



Font

The user may select the size and style of font for the Labels, Text and Bus names tools.    
Selecting this option will enable the changing of the font.    If the font is changed before a tool is 
selected, then this new font will become the default font for all newly placed objects.
Selecting this option with a tool selected, will change the font until a new tool is selected.    
When a new tool is selected the default font will be re-selected and used.
If this option is selected during editing an item, then the font for that particular object will be 
changed.



Line Style

The line style of Lines, Arc Segments, Ellipses, and Rectangles can be changed using this option.

This options enables you to select the colour, size and pattern of a line.

When a line pattern of anything other than a solid line is chosen then the line may only be of 
thickness 1.



Attributes

Any symbol may have an attribute string associated with it.    This string is not shown on the 
design.    The string may be in any format and of any length.

If a symbol has an attribute string then it will be in the netlist output (created by the create netlist 
option in the special menu).

You may change or view a symbol's attribute by selecting the symbol using edit tool on the 
Toolbar, and then selecting this menu option.



Grid Settings

- Show Grid

This causes the grid to be displayed.
If the grid is too fine to show at the current zoom then it will not be displayed.    To see the grid 
zoom in.
If the fine grid is enabled then the points which lie on the normal grid as well are shown as 
crosses.

- Snap to Grid

This option should under normal conditions be selected.

This option makes any mouse position snap to the nearest point on a grid.    This allows the easy 
alignment of objects.    It also ensures when you attempt to connect a wire to a symbol that the 
connection is made correctly.    For this reason snap to grid should always be on.
If the snap to grid feature is turned off then when you attempt to connect a wire to a symbol it is 
very difficult to ensure both the end of the wire and symbols connection point are on the same 
point.    With snap to grid this is made easy.    If they are not on the same point, not only does it 
look untidy when printed but it will also be considered un-connected by the special tools.

- Normal, Fine, User grid spacing

In most cases you will wish to use normal grid spacing.    A fine grid has twice as many points to 
a normal grid and is especially useful for anotating a design and drawing symbols.
If you wish you may specify your own grid spacing by entering the spacing in the dialog box.    
You may enter the units in inches or mm, depending on the Units setting (as described below).



- Units in mm or units in inches

This defines which units are used by the whole program inches or mm.    The ruler and show 
position dialog will reflect the changes.

- Scroll bar increments

This determines by how much the design will be scrolled when the arrows at the side of each 
scroll bar is clicked.



Show Position

This option will cause a dialogue box to be displayed with the current co-ordinates of the mouse 
pointer in the design.
The position is displayed in either inches or mm depending which units are selected by the Grid 
Settings option in the Options menu.

To remove the dialogue box select this option again.



Repeat Directions

This option is a sub-menu with options for the repeat command, and options for use when 
placing labels, text and placing pins.

The Up, Down, Left, Right options specify where an object is placed when it is repeated.

The Name Increment/Name Decrement options specify how label names, text or pin names are 
altered after they are placed.

The Pin Increment/Pin Decrement options specify how the pin numbers are altered after placing 
a pin.    Note that you can only place pins when editing a library.



Re-Draw Window

This causes the whole windows to be re-drawn.

It is possible after many edits of the design that it becomes slightly distorted by stray pixels.    
This option causes these errors to be removed.    (Hopefully you will never need to use this 
option!)



Keypresses Reference
Key Action Menu

Ctrl + n New File
Ctrl + o Open File
Ctrl + s Save File
i Import File
e Export File
Ctrl + p Print File

d Drag Block Edit
m Move Block Edit
o Rotate Block Edit
r Repeat Edit
Ctrl + x Cut Edit
Ctrl + c Copy Edit
Ctrl + v Paste Edit
u Duplicate Block Edit
x Delete Block Edit

c Centre
+ Zoom In
- Zoom Out
s Re-Draw Window Options

F1 Bus Toolbar
F2 Junction Toolbar
F3 Label Toolbar
F4 No Connect Toolbar
F5 Power Toolbar
F6 Wire Toolbar
F7 Arc segment Toolbar
F9 Ellipse Toolbar
F10 Line Toolbar
F11 Rectangle Toolbar
F12 Text Toolbar

Insert Edit Item Toolbar
Delete Delete Item Toolbar

/ Bus Entry(/) Toolbar
\ Bus Entry(\) Toolbar



g Get Toolbar



Toolbar Reference

Click on the tool you wish for help on:



Arc segment

The only arcs which can be drawn are the arcs which represent one quarter of an ellipse.    Arcs 
are for annotating your designs only, they are ignored by all the special tools.

To draw an arc select the starting point with the left hand mouse button.    Then move to the 
ending point and click again with the left hand mouse button.    If the arc bows the wrong way, 
then draw the arc in the other direction.    That is, click with the left hand mouse button in the 
place where you intended to end it, then move the your original starting point and click again.
To cancel drawing an arc click with the right hand mouse button, and you may start a new arc 
from a different point.    Clicking with the right hand mouse button again will select the Edit Item
option in the edit menu.

You may change the width of the line the arc is drawn with by selecting the Line Thickness 
option in the Options menu.

Arcs cannot be edited, but they can be deleted or moved.



Bus

Click with the left hand mouse button in the place you wish to start the line.    Move to where you
wish the line to end and click with the left hand button again.    A bus segment will be placed and 
a new bus segment is now started from this point.
To stop drawing click with the right hand mouse button, and you may start a new bus from a 
different point.    Clicking with the right hand mouse button again will select the Edit Item option
in the edit menu.

Normally the bus is locked to 90 degree positions.    In this mode two line segments are displayed
at once.    However, only one segment is placed at a time when you click with the left hand 
mouse button.    You must click once more to place both the bus segments.
You may also lock to 45 degree angles only, or have no locking at all.    This can be selected from
the edit window.    When these options are used, only one bus segment at a time is displayed.

If you find when you try and place two bus segments in rapid succession and find that only one 
is placed, then the cause is properly due to the double click speed of the mouse being setup so 
that it is too slow.    Go to the Control Panel and alter the double click speed faster.    (See the 
Window's Manuals for more details).

Buses cannot be edited, but they can be moved, dragged or deleted.
Buses can be repeated.



Bus Entry

Bus entries are used to show the connection of a wire to a bus.    There are two types of bus entry,
allowing for connection into the bus from any possible direction.

To place bus entries, select this option in the menu, then move the bus entry to the point you 
wish to place it.    Place it by clicking with the left hand mouse button.
When you have finished placing, either select a new tool or click with the right hand mouse 
button.    This will select the Edit Item in the Edit menu for you.

Bus Entries cannot be edited, but they can be moved or deleted.
Bus Entries can be repeated.



Bus Name

A Bus Name placed across a Bus to indicate the nature of the Bus.    This could be the number of 
conductors in the bus or the name of the Bus.

It is often required to have bars over the letters in a Bus Name.    This can be done by placing the 
` character before each letter that needs a bar over it.    If a whole word needs to have a bar placed
over it then each letter in that word must have a ` before it.

Type the name of the bus in the dialogue box.    As you enter text a rectangle will appear next to 
the mouse, indicating the size and position of the text.
Move this rectangle with the mouse to where you wish to place it and click with the left hand 
button.
You can cancel entering text by clicking with the right hand mouse button.

Bus Names can be edited once placed.    To do so select Edit Item on the Toolbar.    Then click 
with the left hand mouse button on the text to be edited.    A window will appear with the original
text in it.    You can now alter it as necessary.    When finished either click with the left hand 
mouse button on something else to edit, or click with the right hand mouse button.

Bus Names can also be moved and deleted.



Delete Item

This option allow you to delete objects in the design.

NOTE: The operation of this tool has changed, since version 1.21.

To delete an item first select the Edit Item tool.    Select the item to delete by clicking on it with 
the left hand mouse button.    The object will turn grey to indicate it has been selected.    You may 
instead of selecting a single item with the edit tool select a group of items.    These too may be 
deleted.
Now select this option on the toolbar menu to delete the item.

You may undo the deletion by using the undo option in the edit menu.    You may also use 
"Delete Block" in the edit menu to delete items in your design.



Edit Item

This option enables editing of objects already placed in the design.    You may also use this tool 
to move objects in your design and to delete objects in your design.

Once this option has been selected then clicking with the left hand mouse button on an object in 
the design will select that object.    To show it has been selected it will be shown in light grey.
If there is more than one editable object under the mouse pointer, then clicking again with the 
left hand mouse button in the same place will cause a different object to be selected.    Keep 
clicking with the left hand mouse button until the object you wish to edit is selected.

If the object is editable, then a dialogue box associated with the object will be shown enabling 
you to change it.    For example, if you click on a text object then a dialogue box will appear with
the text in it.    You may then change the text in the dialogue box.
End editing an object by clicking with the right hand mouse button in the design window, or by 
selecting a new object to edit using the left hand mouse button.

You may also move objects that are selected.    To do this hold down the left hand mouse button 
on a selected object.    Now move the mouse, with the left hand mouse button held down.    The 
object will be moved with the mouse.    To finish release the left hand mouse button.

You may delete any selected object by using the delete item option on the toolbar.

You may copy any selected object to the clipboard by selecting the Copy or Cut options in the 
edit menu.    Once a selection has been copied to the clipboard it may be pasted into another 
application (such as Microsoft Word), or pasted back into the design.

To select groups of objects you may drag a rectangle around the objects to be selected.    Any 
object within the rectangle will be selected.    Once it has been selected you may delete, move, 
copy or cut the object.    To drag the rectangle, place the pointer in an area of the design where 
there is no object.    Hold down the left hand mouse button and move the mouse.    The rectangle 
will be created.    Release the left hand mouse button to select the objects within the rectangle.



Ellipse

Ellipses are only used to annotate designs.    They are ignored by all the Special tools.

The only ellipses that can be drawn are those which can be enclosed by a rectangle with its edges
parallel to the edges of the design.
To draw an ellipse you must start by moving to one corner of the rectangle that will enclose the 
ellipse (this rectangle is not actually displayed).    Click with the left hand mouse button.    Now 
as you move the mouse the ellipse will be shown.    Once the ellipse is in the correct position 
click again with the left hand mouse button.
To cancel drawing an ellipse, click with the right hand mouse button, and you may start a new 
ellipse from a different point.    Clicking with the right hand mouse button again will select the 
Edit Item option in the edit menu.

You may change the width of the line the ellipse is drawn with by selecting the Line Thickness 
option in the Options menu.

Ellipses cannot be edited, but they can be moved or deleted.



Get

The get options extracts symbols from the libraries listed in the Library setup.
After selecting this option, a dialogue box will prompt you for a symbol name.    Enter a name 
and either click on the OK button or press enter.    You can cancel by clicking on the cancel 
button.
If you are unsure of the name of the symbol you require you can use the Libraries option in the 
library menu.    Click on the library name which contains the symbol you require and click on the
Names button.    This will display a list of all the names of symbols in the library you choose.

Symbols are extracted from the symbol libraries listed in the Library setup.    For more 
information about creating new symbols and manipulating the symbol libraries see the relevant 
section.

Once the name has been entered each symbol library will be searched in turn for the symbol 
name.    If it is found the symbol will be extracted and displayed.

It is possible to rotate the symbol and mirror it.    Mirroring will only make a difference if the 
symbol is asymmetrical.

You can cancel placing the symbol either by clicking with the right hand mouse button, which 
will selected the edit item in the edit menu, or by selecting another tool.

The symbol name is typically it's value such as 12K for a resistor, or 1N141 for a diode etc.    
However, sometimes two values are required to identify the symbol, typically when it is unclear 
what the symbol represents.    In such circumstances a second field (labelled other) is available to
contain additional information about the symbol.

The symbol reference is used to identify the symbol and should be unique.    References can be 
automatically filled in by the generate symbol references in the Special tools menu.    This tool 
replaces all symbol references with a ? in them with a unique reference.    For this reason you 
typically do not have to alter the reference value when initially placing the symbol.

Some symbols represent a single element in a package.    For example a single NAND gate in 
7400.    In this case you can select which of the parts in the package the symbol represents.    The 
power connections will also be made automatically for you, and are not shown on the design.    In
order for this to work properly you must use the same names as used by the symbols for the 
power supply.    For the TTL 74 library the power supply are named VCC and GND.    Make sure 
you type them in upper case.

To select which part per package you actually want, enter a letter (A, B, C etc.) in the box 
beneath the symbol reference box, the pin numbers on the symbol will change accordingly.    The
part per package is also filled in by the generate symbol references, and so does not normally 
need to be entered.
Once you have filled in the edit window, place the symbol using the left hand mouse button.



Connections to the symbol should be via the pins on the symbol.    All connections should be 
made at the end of the pins, otherwise it will not be considered connected by the Special tools.
Sometimes the pins are hidden.    In this case the connection point will be obvious by the design 
of the symbol.    For example, the npn transistor has no visible pins, connection to this symbol is 
via the two diagonal lines of the collector and emitter and the straight line of the base.

You can edit symbols to change their names, reference and orientation.    Do this by selecting the 
edit item in the edit menu, then click with the left hand mouse button on any part of the symbol 
(except the text).    The edit window will appear and you can alter the symbol as necessary.    
When you have finished either click with the left hand mouse button on a new item to edit, or 
click with the right hand mouse button.

Symbols can also be moved or deleted.



Junction

Junctions indicate when two wires meet that they are electrically joined.    This information is 
used by the special tools to generate net lists and check the electrical rules.    When two wires 
meet or cross it is assumed they are not joined unless a junction is placed at the crossing point.

To place a junction select this option, then move the junction to the location in the design where 
you wish to place it and then click with the left hand mouse button.    When you have finished 
placing, either select a new tool or click with the right hand mouse button.    This will select the 
Edit Item in the Edit menu for you.

Junctions cannot be edited, but they can be moved or deleted.



Label

Labels indicate a connection to the wire which runs beneath them.    Any two wires with the same
label name above them are considered to be connected.
This can be useful when two parts of a circuit need to be connected but are a long way apart on 
the diagram, or one point needs to be connected to a large number of others.

It is often required to have bars over the letters in the label.    This can be done by placing the ` 
character before each letter that needs a bar over it.    If a whole word needs to have a bar placed 
over it then each letter in that word must have a ` before it.

Type the text you wish to add in the dialogue box.    As you enter text a rectangle will appear next
to the mouse, indicating the size and position of the text.
Move this rectangle with the mouse to where you wish to place it and click with the left hand 
button.
After placing a label, if the text has a number on the end of it, it is automatically incremented or 
decremented depending on the Name Increment or Name Decrement option selected in the 
Repeat Directions menu (in the Edit menu).
You can cancel entering text by clicking with the right hand mouse button.

Labels can be edited once placed.    To do so select Edit Item on the Toolbar.    Then click with 
the left hand mouse button on the text to be edited.    A window will appear with the original text 
in it.    You can now alter it as necessary.    When finished either click with the left hand mouse 
button on something else to edit, or click with the right hand mouse button.

Labels can also be moved and deleted.



Line

Lines are provided to annotate your diagrams only.    For the most part, they are ignored by all 
the special tools.

Click with the left hand mouse button in the place you wish to start the line.    Move to where you
wish the line to end and click with the left hand button again.    A line segment will be placed and
a new line segment is now started from this point.
To stop drawing click with the right hand mouse button, and you may start a new line from a 
different point.    Clicking with the right hand mouse button again will select the Edit Item option
in the edit menu.

Normally the line is locked to 90 degree positions.    In this mode two line segments are 
displayed at once.    However, only one segment is placed at a time when you click with the left 
hand mouse button.    You must click once more to place both the line segments.
You may also lock to 45 degree angles only, or have no locking at all.    This can be selected from
the edit window.    When these options are used, only one line segment at a time is displayed.

If you find when you try and place two line segments in rapid succession and find that only one 
is placed, then the cause is properly due to the double click speed of the mouse being setup so 
that it is too slow.    Go to the Control Panel and alter the double click speed faster.    (See the 
Window's Manuals for more details).

You may change the width of the line with by selecting the Line Thickness option in the Options 
menu.

Lines cannot be edited, but they can be moved or deleted.
Lines can be repeated.



No Connect

No connects indicate that the symbol, wire or power item is not connected to anything else, and 
should not be connected to anything else.    The electrical rules checker will indicate an error if 
an input is unconnected unless it has a no connect joined to it.    Place no connects on any unused
input or output to avoid this error and indicate that it is intentionally left unconnected.

To place a no connect select this option, then move the cross to the location in the design you 
where wish to place it and then click with the left hand mouse button.    When you have finished 
placing, either select a new tool or click with the right hand mouse button.    This will select the 
Edit Item in the Edit menu for you.

No connects cannot be edited, but they can be moved or deleted.



Power

Power objects are use to show where power is connected to the design.    All power objects 
should have a value, which is the value of the power it provides (such as 5V, GND, 0V etc.).    All
power objects with the same value are considered connected to one another; even if they have 
different shapes.
You should connect wires to the power items at the end of their pins, otherwise they will not 
considered to be connected.

Certain symbols are automatically connected to power without the connection being shown (for 
example the 7400, although no power pins are shown, it is automatically connected to VCC and 
GND).    When using these symbols, you should make sure you use the same power supply 
names as the symbols otherwise the symbol will not be correctly connected to the power supply.

To place power items in to your designs select power from the Toolbar.    Then in the dialogue 
box select the orientation of the power item, it's shape and it's name.    Place the power item by 
clicking with the left hand mouse button.
A range of shapes is provided, and you may use any name. Bars may be added over letters in 
names in the same manner bars can be added to text and labels, that is by placing ` before each 
letter which requires a bar over it.
Once you have finished placing power items click with the right hand mouse button or select a 
new tool.

Power items can be edited.    To do so select Edit Item in the Edit menu.    Click with the left hand
mouse button on the end of the power item's pin.    You can now change it's name, orientation and
shape.    When finished either click with the left hand mouse button on something else to edit, or 
click with the right hand mouse button.
Power items can also be move and deleted.



Rectangle

Rectangles are only used to annotate designs.    They are ignored by all the Special tools.

To draw rectangles, select the tool on the Toolbar.    Then go to the position for one of the corners
of the rectangle.    Click with the left hand mouse button.    Now as you move the mouse the 
rectangle will be shown.    Once the Rectangle is in the correct position click again with the left 
hand mouse button.
To cancel drawing a rectangle, click with the right hand mouse button, and you may start a new 
rectangle from a different point.    Clicking with the right hand mouse button again will select the
Edit Item option in the edit menu.

You may change the width of the line the rectangle is drawn with by selecting the Line Thickness
option in the Options menu.

Rectangles cannot be edited, but they can be moved or deleted.



Text

Text is used only to annotate designs, it is ignored by the special tools.

It is often required to have bars over the letters in the text.    This can be done by placing the ` 
character before each letter that needs a bar over it.    If a whole word needs to have a bar placed 
over it then each letter in that word must have a ` before it.

Type the text you wish to add in the dialogue box.    As you enter text a rectangle will appear next
to the mouse, indicating the size and position of the text.
Move this rectangle with the mouse to where you wish to place it and click with the left hand 
button.
After placing text, if the text has a number on the end of it, it is automatically incremented or 
decremented depending on the Name Increment or Name Decrement option selected in the 
Repeat Directions menu (in the Edit menu).
You can cancel entering text by clicking with the right hand mouse button.

Labels can be edited once placed.    To do so select Edit Item on the Toolbar.    Then click with 
the left hand mouse button on the text to be edited.    A window will appear with the original text 
in it.    You can now alter it as necessary.    When finished either click with the left hand mouse 
button on something else to edit, or click with the right hand mouse button.

Text can also be moved and deleted.



Wire

Wires are used to indicated connections on the circuit diagram.    If you wish to use features such 
as the electrical rules checker or net list generation then you must use wires for this purpose.    If 
you use lines instead of wires to join up points on a diagram then these tools will not work!

Click with the left hand mouse button in the place you wish to start the wire.    Move to where 
you wish the wire to end and click with the left hand button again.    A wire segment will be 
placed and a new wire segment is now started from this point.
To stop drawing click with the right hand mouse button, and you may start a new wire from a 
different point.    Clicking with the right hand mouse button again will select the Edit Item option
in the edit menu.

Normally the wire is locked to 90 degree positions.    In this mode two line segments are 
displayed at once.    However, only one segment is placed at a time when you click with the left 
hand mouse button.    You must click once more to place both the bus segments.
You may also lock to 45 degree angles only, or have no locking at all.    This can be selected from
the edit window.    When these options are used, only one wire segment at a time is displayed.

If you find when you try and place two wire segments in rapid succession and find that only one 
is placed, then the cause is properly due to the double click speed of the mouse being setup so 
that it is too slow.    Go to the Control Panel and alter the double click speed faster.    (See the 
Window's Manuals for more details).

Wires cannot be edited, but they can be moved, dragged or deleted.
Wires can be repeated.



Zoom

The zoom tool enables you to easily enlarge the view of the design.    Once selected you may 
enlarge the view by clicking with the left hand mouse button, and reduce the view by clicking 
with the right hand mouse button.

The position of the mouse pointer, when you zoom in, is moved to the centre of the window.




